YAESU

YCEO1

PC PROGRAMMING SOFTWARE
REFERENCE MANUAL

(for Software Version: 2.XX.xX)

This software is used to program the FTA-750/FTA-550 air band transceiver.
With this software, you can quickly and easily program the FTA-750/
FTA-550 operating channels from your personal computer.

Note: For transceiver software version “2.xx’ only.
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BEFORE UsING

Minimum System Requirements

IBM®-compatible PC

Windows Vista®, Windows 7, or Windows 8 operating system

Up to 20 Megabytes of free hard disk drive space

Mouse or other pointing device

256-color display adapter (24-bit color recommended) and monitor with 640 * 480 reso-
lution or higher

NET Framework 3.5 or 4.0

This reference manual was created using the Windows 7 operating system. Operations and
screen examples may vary based on your operating system.

Note: Support for Windows XP ends April, 2014.

INSTALLATION AND REMOVAL OF THE PROGRAM

To install the YCEO1

1. Download the YCEO1 PC Programming Software from the YAESU website and decom-
press the files to anywhere on your computer. Note that all the files must remain in the
same folder.

2. Run the “setup.exe” in the same folder that you have decompressed the files.

3. Follow the instructions on your computer screen.

If the YCEO1 is successfully installed, a shortcut icon “YCEO1” will appear on the
desktop of your computer. The instruction screen for installing the FTA-750 / FTA-550
device driver will also appear.

4. Follow the instructions on your computer screen.

The device driver will be installed.

To remove the YCEO1 from your computer
1. Click the Start button and then “Control Panel”.

2. Click “Programs” and then “Remove Programs”.
3. Select “YCEO01” then click the menu item “Remove”.

O aaaad

STARTUP OF THE PROGRAM

Double-click the “YCEO1” icon on the desktop of your computer, or click “YCEOQ01” in the
Start menu displayed by clicking the Start button.

To close the YCEO1

Click the [X] button in the top right corner of the YCEO1 window, or click “EXxit” in the “File”
menu of the YCEO1.
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MobDEL SETUP

Items and values available on the YCEO1 depend on the model of the radio and the region of
the world to be used.

To select the model

1. Click “Edit” on the menu bar. 4 veED1 pC program for FTA-750/550 ==

File | Edit | Transfer Region Option Help

2. Select either of “FTA-750" and “FTA- | _[-[ s 15 mm

FTA-550 |

29 b (14 29 H
550” under the item “Model”. - Wemry ook

i Memory Group Name
Weather Channels

YAESU

[UpM[Down)[Left}[Right] Change of a Selection item. FTA-750

To select the target region

1. Click “Region” on the menu bar. 801 progrom for TR TS0/ B
. . . Flle Edit Transfer | Region | Option  Help
2. Select either of the following items. EFEE L
. r EXP
EU: For use in Western Europe and || -enon oo

Memory Group Name
Weather Channels

other EU countries
EXP: For use in the regions other than
those covered by the items EU
and USA YAESU
USA: For use in North America, Cen-
tral America, and South America

[UpMDown)LefV[Rightl.Change of a Selection item. FTA-750

. _____________________________________________________________________________________________________________________|
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MAIN SCREEN

The YCEO1 main screen consists of two ma-
jor sections: the System Tree View (left
pane) and the list of detailed settings or en-
tries of each category (right pane).

The System Tree View includes four cate-
gories: “Setup”, “Memory Book”, “Mem-
ory Group Name”, and “Weather Chan-
nels”.

“Setup’” Category

=4 YCE01 PC Program for FTA-750/550

File Edit Transfer Region

BEFFEL]

Option  Hel

P

(E=8 ECH Fx3)

Memory Book
Memory Group Name
Weather Channels

YAESU

[UpMDown)LefV[Rightl.Change of a Selection item.

FTA-750

Double-click the “Setup” category to display the setup list (“Configuration”, “COMM

Setup”, and “GPS Setup”), then click the desired item to display its contents.

“Configuration”
This item includes the parameters set in the [Soveireeesmmeremsss R
CONFIGURATION menu of the SETUP | iuswa
mode on the FTA-750/FTA-550 transceivers. o s
Lamp [ExpPOKey |
Dimmer: —
. . u Key Beep 3 -
This parameter selects the brightness A
of the LCD display. Available values soeyses [
are “Level 17, “Level 27, “Level 37, —
(13 29 (14 29 b Function Reset
Level 47, “Level 5” (brightest), and é
“Off”c COMM & GPS Reset
Configuration Reset
Lamp:
This parameter sets the backlight opera- =
tion of the LCD display and keypad.
Available selections are:
Off: Sets the backlight for the LCD and keypad to OFF.
Continuous: Sets the backlight for the LCD and keypad to continuously ON.
Key On: Sets the backlight for the LCD and keypad to illuminate for

5 seconds when any key is pressed.
- ]

Yaesu Musen Co., L1p.
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MAIN ScREEN

EXP PO / Key: Sets the backlight for the LCD and keypad to illuminate for
5 seconds when any key is pressed, or to illuminate continuous-
ly when connected to an external DC power source.

Contrast:
This parameter selects the sharpness of the LCD display from “1” to “30” levels.

Key Beep:
This parameter selects the loudness of the beeps heard when a key is pressed. Available
values are “1” to “5” (loudest) and “Off”.

Timer Alarm:
This parameter toggles the alarm feature of the timer “On” or “Off”.

Battery Save:
This parameter sets the operation of the battery saver.
Available selections are:
Off:  Sets the battery saver to OFF.
50%: Sets the battery saver to allow reception for 100 ms after 100 ms of no operation.
70%: Sets the battery saver to allow reception for 100 ms after 250 ms of no operation.
80%: Sets the battery saver to allow reception for 100 ms after 450 ms of no operation.
90%: Sets the battery saver to allow reception for 100 ms after 900 ms of no operation.

Lock Select:
This parameter selects the controls to be locked when the LOCK key is pressed. Avail-
able values are “Key Lock”, “Dial Lock”, and “ALL”.

Reset:

Settings or data can be cleared by category. When “Factory” is selected, all the settings

and data will be reset to factory default.

Click the [Reset] button of the desired category to initialize settings or to erase data.

O If you start a reset before connecting a radio to your computer, settings you have en-
tered on the YCEO1 will be cleared.

O Ifyou start a reset after connecting a radio to your computer, the radio’s settings and
data will be cleared.

Note: See Page 18 for details about the connection between the radio and your computer.

Page 6 Yaesu Musen Co., LTp.



YCEOI REFERENCE MANUAL
1

MAIN SCREEN

“COMM Setup”

This item includes the parameters mainly set [ sogan oo e
. File Edit Transfer Region Option Help
in the COMM SETUP menu of the SETUP | | |al 4l #g
. I Setup u Usable Frequency Ban
mode on the FTA-750/FTA-550 transceivers. || ~wmse | “P0mme
GPS Setup ¥ 833 kHz
Usable Frequency Band: gl e A
These parameters determine which of the = Auiotiss Lesr ) [or ]
u Dual Watch Frequency .
possible channel groups shall be “Used « SoitFrequency —
(¥ )” or “Not Used (1" )” for the radio. scausand [iLEAD 2]
SCAN m Resume Time m
COMM Band. Enables or dlS' DualWatch [on  +] —I: PITSCANSTOP [on -]
s TXTOT 5 min - u VOX On e
ables the receptlon = MIC SELECT [wrmc <] u VOX LEVEL [Leverz <]
. B u Side Tone Off - = VOX Delay Time 1.5sec -
and transmission oroicncont. [lema 3]
OIl the NAV band [UpMDown)[Left}Rightl:Change of a Selection item. FTA-T50

(108.000 through 117.975 MHz) and the COM band (118.000
through 136.975 MHz).

COMM Band (8.33 kHz): Enables or disables the adjustment of the operation frequency
by 8.33 kHz step on the COM band.

Weather CH Band: Enables or disables the reception of the ten weather channels.

Weather CH Band (Weather Alert): Toggles the reception of the weather alert sig-
nals “On” or “Off” when the “Weather CH Band” parameter is
set to “Used (# )”.

Emergency Call:
This parameter toggles the quick access feature to the emergency frequency
(121.500 MHz) with the [121.5] key of the radio “On” or “Off”.

Auto Noise Limiter (ANL):
This parameter toggles the automatic noise reduction feature “On” or “Off”.

Dual Watch Frequency [MHz]:
This parameter sets a channel to be used during the dual watch operation.

Split Frequency [MHz]:
This parameter sets the transmission channel to be used during the NAV band operation.

_______________________________________________________________________________________________________________________________|
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MAIN ScREEN

SCAN BAND (SCAN BAND):
Select the band to be scanned.
“ALL BAND” scans both the COM and NAV bands between 108.000MHz and
136.975MHz.
“COM BAND” scans the COM band between 118.000MHz and 136.975MHz.
“NAV BAND” scans the NAV band between 108.000MHz and 117.975MHz.

SCAN BAND (SCAN):
This parameter toggles the scan feature “On” or “Off.”

SCAN BAND (Resume Time):
This parameter selects the scan resume time. Available values are “0 sec”, “1 sec”,
“2 sec”, “3 sec”, and “5 sec”’.
When this parameter is set to “1 sec”, “2 sec”, “3 sec”, or “5 sec”, the scanner will
hold for the selected period (seconds), then resume whether or not the other station is still
transmitting. When this parameter is set to “Off”, the scanner will stop when a signal is
received, and will not restart.

SCAN BAND (PTT SCAN STOP):
This parameter defines whether the scan function shall be aborted (“On’) or not aborted
(“Off”) when the PTT switch is pressed while scanning is engaged.

SCAN BAND (Dual Watch):
This parameter toggles the dual watch feature “On” or “Off”.

TX TOT:
This parameter selects the time-out time of the transmission. Available values are “1 min”,
“2 min”, “3 min”, “4 min”, “5 min”, and “Off”.
When this parameter is set to “1 min”, “2 min”, “3 min”, “4 min”, or “5 min”, the
radio will shut off the transmission after it continues for the selected period (minutes).
When this parameter is set to “Off”, the transmission will not be shut off.

MIC SELECT:
This parameter toggles the operation of the internal microphone “INT MIC” or “EXT

MIC”.
When this parameter is set to “EXT MIC”, the radio’s PTT switch controls the external
microphone on a headset, etc.

. _______________________________________________________________________________________________________________________________|
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MAIN ScREEN

Side Tone:
This parameter selects the side tone level when an external headset is connected to the ra-
dio. Available values are “MIN”, “Level 17, “Level 27, “MAX”, and “Off”.

AF Pitch CONT.:
This parameter selects the operation of the audio filter.
Available selections are:

Normal: Sets the audio filter to OFF.
LOW CUT: Sets the audio filter to cut off the lower range of sound.
HIGH CUT: Sets the audio filter to cut off the higher range of sound.
HIGH AND LOW CUT: Sets the audio filter to cut off the higher and lower range of
sound.
VOX:

This parameter toggles the VOX feature “On” or “Off” when an external headset is con-
nected to the radio.

VOX LEVEL:
This parameter is inactive until the parameter VOX is set to “On”.
This parameter selects the sensitivity of the VOX system. Available values are “MIN”,
“Level 17, “Level 27, “Level 3”, and “MAX".

VOX Delay Time:
This parameter is inactive until the parameter VOX is set to “On”.
This parameter selects the delay time of the VOX system. Available values are “0.5 sec”,
“1.0 sec”, “1.5 sec”, “2.0 sec”, and “3.0 sec”.

Yaesu Musen Co., L1p. Page 9
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MAIN SCREEN

“GPS Setup”
This item includes the parameters mainly set (2o scrogenorrmmsoss Fo =
. File Edit Transfer Region Option Help
in the GPS SETUP menu of the SETUP mode | | |ul 4 g
. - Setup
on the FTA-750 transceiver. Contgurton » Uit Pawer on |
: . u Power Save Auto -
This appears only when the FTA-750 is || wmvsex |\ fmmmm
selected in the “Edit” menu of the YCEO1. 5 Weather Chanmels on E|
- Display | j Offset ‘ x j Fonﬂall j
Unlt Power: -UniloIMeasureU::tup - -
This parameter toggles the internal GPS B s
unit ‘60n5, OI' “Off”. sBas |on -
u Logger Interval m
Power Save: = Logger Data Erase Erase
This parameter sets the operation of the o =
[Up)Down}[Lef}[Rightl:Change of a Selection item. FTA-750

GPS unit.
Available selections are:

Off:

Sets the GPS unit to operate all the time.

AUTO: Sets the GPS unit to operate only when a GPS signal is received or the radio en-

ters the GPS or NAVI mode.

50%: Sets the GPS unit to operate 3 sec after 3 sec of no operation.
75%: Sets the GPS unit to operate 3 sec after 9 sec of no operation.
90%: Sets the GPS unit to operate 3 sec after 27 sec of no operation.

Location Format:

This parameter selects the notation of position information. Available values are
“ddd°mm’ss” (degrees, minutes, seconds)”, “ddd°mm.mm (degrees, minutes, hun-
dredths of a minute)”, and “ddd®mm.mmm (degrees, minutes, thousandths of a minute)”.

Pinning:

This parameter toggles the position information update feature “On” or “Off”.

Time Setup (Display):

This parameter sets the time to be shown in local time (“Local”) or UTC time (“UTC”).

Time Setup (Offset):

This parameter sets the time offset for your local time from the UTC time.

Time Setup (Format):

This parameter sets the radio to be shown in 12-hour (“12H”) or 24-hour (“24H”) for-

mat.

|
Yaesu Musen Co., L1p.
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MAIN SCREEN

Unit of Measure Setup (Distance):
This parameter selects the unit of measurement for distance between the target point and
your position. Available values are “Nautical Mile”, “Statute Mile”, and “Kilometer”.

Unit of Measure Setup (Speed):
This parameter selects the unit of measurement for SOG (speed over ground). Available

99 <6

values are “knots”, “mph (miles per hour)”, and “km/h (kilometers per hour)”.

Unit of Measure Setup (Altitude):
This parameter selects the unit of measurement for your altitude. Available values are
“Feet” and “Meters”.

Differential GPS (SBAS):
This parameter toggles the SBAS (satellite-based augmentation system) feature “On” or
“off’ﬂ.

Logger Interval:
This parameter selects the interval time of logging. Available values are “1 sec”, “3 sec”,
“5 sec”, “10 sec”, and “30 sec”.

Logger Data Erase:
The log data recorded in the memory of the radio can be cleared to free memory for fu-
ture recordings.
Click the [Erase] button to erase the log data after connecting the radio to your comput-
er.
Note: See Page 18 for details about the connection between the radio and your computer.

Logger Data Transfer:

The log data recorded in the memory of the radio can be retrieved to use for mapping,

analysis, or other purpose.

Click the [Start] button to copy the log data after connecting the radio to your computer.

Notes:

O See Page 18 for details about the connection between the radio and your computer.

O You may choose the file format of the log data from the NMEA and KML on the “Save
As” window displayed after clicking the [Start] button. See the reference manual of
your application utilizing the log data to determine the file format.

Yaesu Musen Co., L1p. Page 11
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“Memory Book” Category.
Double-click the “Memory Book™ category to display the list of items (entries of channel or
destination), then click the desired item to display its detailed information.

Adding a New Entry

1. Click the “Memory Book” category | hveet perrosrsm for Fraso/sse = =
to display the list of entries on the right | |-jul /s
:,eel::, Book Tag Name Frequency | Group Position Lat
pane. " Kansas) _mm-sgi
5 as Vegas Las Vegas 124.300 NO GROUP
2. Cth the [NEW] button at the bOttOl’n Of " {tosén:e\e];] Los Angeles 133.800 GROUP1 LS
lemory Group Name
the Screen. [+-Weather Channels

3. Set the desired items, referring to the
descriptions in the next section.
4. Click the [SAVE] button at the bottom of

the screen.
<] | »
NEW EDIT | DELETE ‘ 003 / 200
[Double clickJ[Enter]:Jump the Setting screen. FTA-750
Editing a Memory Book Entry
You may also display the detailed informa- [Zve reremm o Fo =

. . . . . File Transfer Region Option  Help
tion of an entry by selecting it from the list in | | [ul 5/ #ig

Setup

the right pane then clicking the [EDIT] but- ||z uenose sugtoms  [reoverss

ton at the bottom of the screen. Mmooy e o
Memory Group Name u Group ’W‘

Weather Channels

» Position Lat . -

After you set the desired items, click the " O— 1

[SAVE] button at the bottom of the screen. R
u RWY True Course ——
Tag Name: T

This parameter allows you to assign an
alphanumeric name to the entry for easy
identification and search.

Up to 15 characters are available.
Available characters are 0 to 9, A to Z, a to z, plus (+), hyphen (-), comma (,), slash ( /),
left bracket ([ ), right bracket ( ] ), period (.), asterisk (*), ampersand (&), and space.
Note: This parameter cannot be left blank.

SAVE

[Up)Down}[Lef}[Rightl:Change of a Selection item. FTA-750

Page 12 Yaesu Musen Co., L1p.
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Frequency [MHz]:

This parameter sets the channel frequency of the Operating Input Value
entry. Frequency [MHZ]
The FTA-750/FTA-550 are set up with default (8;23 kHz Step) —
channel steps of 25 kHz (NAV and COM bands). If 1**'0000 MHz 1**'005
you need to change the channel step increments, 1**'0083 MHz 1**'010
set the 8.33 kHz check box to “ON (F )” under 1**'0166 MHz 1**'015
the Usable Frequency Band item in the 17.0250 MHz 17.030
« ” 1**.0333 MHz 1**.035
COMM Setup” category.

1**.0416 MHz 1**.040
Notes: 1**.0500 MH 1**.055
O Converted values according to the table on the ' z '

) . ) . 1**.0583 MHz 1**.060
right must be input when using frequencies by - =
8.33 kHz step 1**.0666 MHz 1**.065

’ o , 1** 0750 MHz 1** 080

O Frequencies by 8.33 kHz step are available ” "

ly on the COM band (118.000 through 17.0833 MHz 17.085
only ‘ g1 1" 4= 0916 MHz 1%*.090
136.975 MHz).
Group:

Select the group where you want to register memory channels.

ALL:

Group including all the memory channels.

FLAG:

Group of memory channels you have set the item “Flag” when storing.
Group1 to Group8:
Group of memory channels you have set the groups “Groupl” to “Group8” when storing.

Note: The names of Groupl to Group8 can be changed from “Memory Group Name”. See
the “Memory Group Name” category (page 14).

Position (Lat):
This parameter sets the latitude of the entry with the selection of “N (north)” or “S
(south)”.
Note: The format of this parameter reflects the setting on the Location Format item in
the “GPS Setup” category.

Position (Lon):
This parameter sets the longitude of the entry with the selection of “E (east)” or “W
(west)”.
Note: The format of this parameter reflects the setting on the Location Format item in
-

Yaesu Musen Co., L1p. Page 13
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the “GPS Setup” category.

SCAN Memory:
This parameter sets memory scan of the entry to “On” or “Off”.

RWY True Course:
This parameter allows you to set the RWY True Course for ILS navigation.
This allows you to display the ideal course of approach on the CDI of the radio when re-
ceiving the localizer signal of ILS on the entered channel.
This appears only when the FTA-750 is selected in the “Edit” menu of the YCEO1.

Note: This parameter is programmable only on the YCEO1.
Shift:

This parameter toggles the moving of a spurious response “On’ or “Off” if the frequency
of the entry is affected by the CPU clock of the radio.

Note: This parameter is programmable only on the YCEO1.

Deleting a Memory Book Entry

1. Click the “Memory Book” category to display the list of entries on the right pane.
2. Select the desired entry on the list.

3. Click the [DELETE] button at the bottom of the screen.

4. Click the [Yes] button on the dialog box appearing on the display.

“Memory Group Name” Category

You can change the group name of each Fmemenes =
(13 2 (14 29 File Edit Transfer Region Option Help
group ID for “GP1” to “GP8”. EEEE
- Setup Group ID Group Hame
1. Click the “Memory Group Name” ||” v C——
{t :X:: ‘525] GP3 GROUP3
Category. GPa GROUPA
. . . [+-Weather Channels GP5 GROUPS
The list of group IDs will be displayed o grous
on the right pane.

2. Click the group name you want to
change, then enter the new group name.
The group name will be changed.

[UpMDown}Lefiy[Right}:Change of a Selection item FTA-750

. __________________________________________________________________________________________________________________________|
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MAIN SCREEN

“Weather Channels” Category

Double-click the “Weather Channels” cat-
egory to display the preprogrammed weather
channels, then click the desired channel to
display and edit its information.

WX CH:
This parameter indicates the provided
memory number of the channel.

Frequency:
This parameter indicates the frequency of
the channel.

Tag Name:

=4 YCED1 PC Program for FTA-750/550
File Edit Transfer

Region  Option Help

[E=8 N

é Wealherchannelﬁ
WX01[WX01]
WX02[WX02]

WX04[WX04]
WXO5[WX05]
WXO6[WX06]
WXOTIWX0T]
- VIXO08[WX08]
- WX09[WX08]
L WX10[WX10]

= WXCH

u Frequency

= Tag Name

u SCAN Memory

[UpMDown)LefV[Rightl.Change of a Selection item.

WX03
162.475

[wxo3

or ]

FTA-750

This parameter allows you to assign an alphanumeric name to the channel for easy iden-

tification and search.
Up to 15 characters are available.

Available characters are 0 to 9, A to Z, a to z, plus (+), hyphen (-), comma (,), slash ( /),
left bracket ([ ), right bracket ( ] ), period (.), asterisk (*), ampersand (&), and space.

SCAN Memory:

This parameter sets memory scan of the channel to “On” or “Off”.

Yaesu Musen Co., L1p.
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MEenu

The YCEO1 has six menu categories, which are displayed on the menu bar of the YCEO01
window. This section describes the items unique to the YCEO1 under each menu.

“File”

This menu performs the opening, saving, and printing of files with an extension “.dat”, which
include the settings and channel memory of the radio.

“Print” » “Print Option”

This sub-item allows you to select the cate-
gories in the “System Tree View” whose
data are to be output for printing or saving as
plain text.

Only the files selected in the Print Option di-
alog box “ON (¥ )” will be output.

After you change the setting of the check
boxes, click the [Save] button of the dialog
box.

“Print to File”

This item allows you to save the settings you
are opening and editing, in plain text.

A window showing the settings in the format
to be saved will appear on the display.

To save it, click the “File” menu at the top
left of the window, and select “Save As...”.
To cancel the saving, click the [OK] button at
the bottom of the window.

=4 YCED1 PC Program for FTA-750/550 [=[@][==]
File Edit Transfer Region Option Help
= TR
[+- Setup
E|--Memory Book
[Kansas]
[Las Vegas]
[Los Angeles] Print Option @
Memaory Group Name
[+-Weather Channels
¥ Setup
¥ Memery Book
¥ Weather Channels r’
=
Save Cancel ‘
[UpMDown}[Lefif[Righf:Change of 3 Selection item FTA-750
=H YCED1 PC Program for FTA-750/550 =@ [=]
File Edit Transfer Region Option Help
11 =

Setup
[=-Memory Book
[Kansas]

=} Print to File
File

(o o e |

[Las Vega

[Los Angel
Memory Groug| cont
[ Weather Chan| |gzey

Level 5
EXF FO/Key
15

3

on

508

ALL

Enable
Enable
Enable

[ =]

[Up)Down}[Lef}[Rightl:Change of a Selection item.

FTA-750

|
Yaesu Musen Co., L1p.
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MAIN

MENuU

(11 Edit”
“Model”

This item allows you to select the model of radio you are going to program the settings and

channel memory (see Page 4).

“Transfer”

This menu performs the downloading or uploading of information to/from a radio. To down-
load/upload data to/from your radio, make a proper connection between the computer and
your radio (see the next page) and turn on the radio before selecting the “Transfer” menu.

“Program to Radio”

The “Program to Radio” item downloads
the data from the computer to the radio.

Select the “Program to Radio” (or click

the 8| button) to open the pop-up window,
then click the [Start] button to start down-
loading.

“Read from Radio”

The “Read from Radio” item uploads the
stored data from the radio to the computer.

Select the “Read from Radio” (or click the

| button) to open the pop-up window, then
click the [Start] button to start uploading.

= YCED1 PC Program for FTA-750/550
File Edit Transfer Region Option Help

EIFIRETE

[==]r=]

Setup
Memory Book

Memory Group Name

= 3
Weather Channels :& REEnEiEE o

=)

Start

If you want to program a data to the radio,
please click the "Start" button.

"

Cancel |

[UpMDown)LefY[Rightl.Change of a Selection item.

FTA-750

* YCEO1 PC Program for FTA-750/550
File Edit Transfer Region Option Help

EIFIRETE

Setup

up Nan (" .
Weather Channels :& RENEmGEL:

=)

:

tart

If you want to read a data from the radio,
please click the "Start" button.

o

&y

Cancel |
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Programming Setup

1. Turn the transceiver off.

2. Connect the computer to the transceivers DATA jack using the USB Cable
(T9101606) supplied with the FTA-750/FTA-550, as shown below.

3. Press and hold the [MENU] key while turning the transceiver on, to enter the pro-

gramming mode.

The transceiver will beep and display the battery indicator only on the LCD.

4. Select the port from the list in the “Port” item under the “Option” menu of the

YCEO1.

&

POWER 4
switch

MENU
key

|

USB Cable
(Supplied with
FTA-750/FTA-550)

Page 18

Yaesu Musen Co., L1p.



YCEOI REFERENCE MANUAL
1

MaAIN MENU

“Region”
This menu allows you to initialize the settings of the programming data to those suitable for
the specified region of the world (see Page 4).

“Option”

This menu allows you to set up the program according to your computer’s configuration.
“Port”

This item selects the communication port used to connect the FTA-750/FTA-550.

If you connect multiple transceivers or other USB devices to your computer, all the active
ports will be listed here. Select an appropriate port before resetting a transceiver, erasing or
reading the GPS log data, or programming or reading the settings in a transceiver.
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